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Purpose of this Lab 

After completing this lab, you should be able to create a report as per the stated business requirement 

using different types of visualization. You should also be able to create “Web” and “Mobile” specific views 

for the report. 

 

 

Visualizing Data      Scenario 

The CMO (Chief Medical Officer) of a healthcare organization wants to analyze the performance of his 

hospital. He wants to judge the performance in terms of the quality of healthcare service provided to the 

patients which is very important from the stand point of, 
 

1. Producing different healthcare statistics that can help in improving the overall patient care. 

2. Becoming NABL compliant. 

Similarly, he also wants to judge the performance of his hospital in terms of the revenue generated by 

selling different types of products and services. The points below describe the detailed requirement of the 

dashboard. Based on last 4 years data, the CMO wants to know the, 
 

1. Number of OPD, IPD and Emergency patient visits. 

2. Distribution of patients in different health categories. 

3. The efficiency of the hospital in curing different type of diseases. 

4. The top performing products and services of the hospital in terms of revenue generation and units 
sold. 

5. The death causing diseases across, 

a. Various age groups 

b. Cities 

c. Gender 

Keeping this requirement in mind we have already shaped our data, in the previous module. So now let’s go 

ahead and build different visuals and create a dashboard. 

 

Creating a Report 

Creating a page called “Hospital Performance” 

1. Open the previously saved “Healthcare Performance Dashboard”. 

2. Navigate to the “Report” view. 

3. Right click on the page name at the bottom and select “Rename Page”. 
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4. Name the page as “Hospital Performance”. 

5. Click anywhere on the white layout area and navigate to the “Format” pane. 

6. Expand the “Page Background” section and change the “Color” to #D0EEF7. You need click on 

“Custom Color” option to set the color using this hex code. 

 

 
 

7. Navigate to the “View” menu and from the “Page View” list, select “Fit to Width”. This would make 
the page responsive. 

 
 



 
 

 

Power BI 

Module 3 

Creating Card Visuals 

Using this visual we’d like display different KPIs of the business. Follow the below mentioned steps to 
create this visual. 

 

1. From the visualization gallery, select “Card” and navigate to the “Fields” pane. 

2. Drag and drop “Visit Count” measure (from Visits table) on the “Fields” box. 

3. Under the “Visual Level Filters” section, drag and drop the “Visit Type” dimension. 

4. Expand “Visit Type” and choose the “Filter type” as “Basic Filtering”. 

5. From the checkboxes below make sure “OPD” is the only option that is checked. 

 

 

 

6. Navigate to the “Format” pane. 

7. Make sure the that the following options are turned off. 

a. Category label 

b. Word wrap 

c. Background 

d. Lock aspect 

8. Turn on and expand the “Data Label” section and make sure, 

e. “Color” is set to #666666. 

f. “Display” is set to “None”. 

g. “Text” is set to 25. 
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9. Turn on and expand the “Title” section and, 

h. Enter “OPD Visit Count” as the “Title Text”. 

i. Set the “Font Color” to #FFFFFF. 

j. Set the “Background Color” as #29B600. 

k. Set the “Alignment” to center. 

l. Set the “Text” to 20. 

10. Turn on and expand the “Border” section. 

m. Set the “Color” as # 666666. 

11. Create two duplicates of the card visual you just created (CTRL + C and then CTRL + V). 

12. Select the first duplicate and navigate to the “Fields” pane. 

n. Set the “Visit Type” filter to “IPD”. 

o. Navigate to the “Format” pane and expand the “Title” section. 

p. Enter “IPD Visit Count” as the “Title Text”. 

q. Change the “Background Color” to #0089CA. 

13. Select the second duplicate and navigate to the “Fields” pane. 

r. Set the “Visit Type” filter to “Emergency”. 

s. Navigate to the “Format” pane and expand the “Title” section. 

t. Enter “Emergency Visit Count” as the “Title Text”. 

u. Change the “Background Color” to #CF9303. 
 

 

 

Creating a Donut Chart 

Using this visual we’d like to analyze the basic health condition of the patients based on their BMIs 

which is calculated based on the vital signs. So, we’d like to see the distribution of patients across 

different health categories. Follow the below mentioned steps to create this visual. 
 

1. Select “Donut Chart” from the visualization gallery and navigate to the “Fields” pane. 

2. Drag and drop “BMI Category” (from Visits table) dimension on the “Legend” box. 

3. Drag and drop “Visit Count” measure from the same table and drop it on the “Values” box. 

4. After dropping on the measure on the “Values” box, click on the small down arrow icon that 

appears to the right of “Visit Count” and choose “Show value as” – “Percent of Grand Total”. 
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5. Navigate to the “Format” pane and make sure the following options are turned off. a. Legend 

b. Background 

c. Lock aspect 
6. Expand the “Data Colors” section and make sure, 

a. The color for “Normal” is set to #01B8AA  

b. The color for “Obese” is set to #374649. 

c. The color for “Overweight” is set to #FD625E. 

d. The color for “Underweight” is set to #F2C80F. 

7. Turn on and expand the “Data Labels” section. 

a. Set the “Color” to #666666. 

b. Set the “Display Units” to “Auto”. 

c. Set the “Label Style” to “Category, percent of total”. 

d. Set the “Text” to 15. 

8. Turn on and expand the “Title” section. 

a. Enter “Patients by Health Category” in the “Title Text” box. 

b. Set the “Font Color” to #FFFFFF. 
c. Set the “Background Color” to #015C55. 

d. Set the “Alignment” to center. 

e. Set the “Text” to 20. 

9. Turn on and expand the “Border” section. 

a. Set the “Color” as # 666666. 
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Creating a Scatter Chart 

Using this visual we’d like to analyze which diseases caused more admissions in the hospital, longer stay 

in the hospital, and eventually caused patient death. This way we can judge the hospital’s 

capability/incapability to cure different types of diseases. Follow the below mentioned steps to create 

this visual. 
 

1. From the visualization gallery select “Scatter Chart” and navigate to the “Fields” pane. 

2. Drag and drop “Diagnosis Name” dimension (from Diagnosis Master table) on the “Details” box. 

3. From the “Visits” table drag and drop, 

a. “Length of Stay” on the “X Axis” box. 

b. “Admission Count” on the “Y Axis” box. 

c. “Visit Count” on the “Size” box. 

d. Navigate to the “Format” tab and expand “Data Colors” section. 

e. Click on the ellipsis next to “Default color” and select “Conditional formatting”. 

 

f. On the “Default color – data colors” window, make sure “Format by” is set to “Color scale”. 

g. “Based on fields” is set to “Death count”. 

h. “Lowest value” color is set to #088B02. 
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i. “Highest value” color is set to #FF0000. 

j. Click on ok to save the settings. 

 

 
 

4. Make sure the following options are turned off. 

a. Category labels 

b. Color by category 

c. Background 

d. Lock aspect 

5. Turn on and expand the X-Axis section. 

a. Set “Scale type” as “Linear”. 

b. Set “Color” as #666666. 

c. Set “Text” as 15. 

d. Set “Display” to “Auto”. 

e. Turn on “Title”. 

f. Set “Style” as “Show title only”. 

g. Set “Title color” to #666666. 

h. Set “Title text size” to 15. 

6. Turn on and expand the Y-Axis section. 

a. Set “Position” to “Left”. 

b. Set “Scale type” to “Linear”. 

c. Set “Color” as #666666. 

d. Set “Text” as 15. 

e. Set “Display” to “Auto”. 
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f. Turn on “Title”. 

g. Set “Style” as “Show title only”. 

h. Set “Title color” to #666666. 

i. Set “Title text size” to 15. 

7. Turn on and expand the “Title“ section. 

a. Enter “Hospital Performance in Handling Disease” as the “Title Text”. 

b. Set the “Font color” as #FFFFFF. 

c. Set the “Background color” as #015C55. 

d. Set the “Alignment” to center. 

e. Set the “Text” to 20. 

 
4. Turn on and expand the “Border” section. 

a. Set the “Color” as # 666666. 
 

 
 

 
 
 
 

 
 
 
 
 
 
 
 

 
 

 
 



 
 

 

Power BI 

Module 3 

 

Creating a new page called “Analysis by Charge Group” 

1. Create a new page and name it as “Analysis by Charge Group”. 

2. Click anywhere on the white layout area and navigate to the “Format” pane. 

3. Expand the “Page Background” section and change the “Color” to #D0EEF7. You need click on 

“Custom Color” option to set the color using this hex code. 

4. Navigate to the “View” menu and from the “Page View” list, select “Fit to Width”. 

Creating Card Visuals 

1. Copy any of the card visual created in the previous page and paste it on the current page. 

2. Select the copied card visual and navigate to the “Fields” pane. 

a. Drag the “Revenue” measure (from Billing table) and drop it on the “Fields” box. 

b. Navigate to the “Format” pane and expand the “Title” section. 

c. Enter “Revenue Generated” as the “Title Text”. 

d. Change the “Background Color” to #29B600. 
3. Create another copy of this visual, select the new visual and navigate to the “Fields” pane. 

a. Drag the “Qty Sold” measure (from Billing table) and drop it on the “Fields” box. 

b. Navigate to the “Format” pane and expand the “Title” section. 

c. Enter “Units Sold” as the “Title Text”. 

d. Change the “Background Color” to #0089CA. 

 

Creating a Clustered Bar Chart 

Using this visual we’d like to see which products and services has generated more revenue for the 

hospital. Follow the below mentioned steps to create this visual. 
 

1. From the visualization gallery select “Clustered bar chart” and navigate to the “Fields” pane. 

2. Drag the “Charge Group” dimension from the “Billing” table and drop it on the “Axis” box. 

3. From the same table drag and drop “Revenue” and “Qty Sold” measures on the “Value” box. 

4. After dropping on the measure on the “Values” box, click on the small down arrow icon 

that appears to the right of “Revenue” and choose “Show value as” – “Percent of Grand 

Total”. 

5. Repeat the same step for “Qty Sold” as well. 
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6. Navigate to the “Format” pane and make sure the following options are turned off. 

a. Background 
b. Lock aspect 

7. Turn on and expand the “Legend” box. 

a. Set “Position” to “Top”. 

b. Turn on “Title”. 

c. Set the “Color” to #666666. 
d. Set the “Text” to 15. 

8. Turn on and expand Y-Axis. 

a. Set “Position” to “Left”. 

b. Set “Color” to #666666. 
c. Set “Text” to 15. 
d. Set “Minimum category width” to 20. 

e. Turn off “Title”. 
9. Turn on and expand X-Axis. 

a. Set the “Scale type” to “Linear”. 
b. Set “Color” to #666666. 
c. Set “Text” to 15. 

d. Set “Display” to “Auto”. 
e. Turn off “Title”. 

10. Expand “Data colors” section. 

a. Set “%GT Revenue” color to #007FAF. 
b. Set “%GT Qty Sold” color to #C44100. 

11. Turn on and expand “Data labels”. 
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a. Set “Color” to #666666. 

b. Set “Display” and “Position” to “Auto”. 
c. Set “Text” to 12. 
d. Turn off “Custom”. 

12. Turn on and expand “Title” section. 

a. Enter “Revenue and Units sold by Charge Group” as “Title Text”. 

b. Set “Font color” to #FFFFFF. 
c. Set “Background color” to #015C55. 
d. Set “Alignment” to center. 

e. Set “Text” to 20. 
13. Turn on and expand the “Border” section. 

Set the “Color” as # 666666. 

 

Creating Multi-row Cards 

Using this visual we’d like to see the top performers in different categories. For example, 
 

• Top physicians by the number of patients attended. 

• Most frequently prescribed medicines. 

• Most frequently ordered procedures 

and lab tests. Follow the below mentioned 

steps to create this visual. 



 
 

 

Power BI 

Module 3 

1. From the visualization gallery select “Multi-row” card and navigate to the “Fields” pane. 

2. From the “Doctor Master” table drag and drop the “Primary Physician” and “Specialty” dimensions 
on the “Fields” box. 

3. From the “Visits” table drag and drop the “Visit Count” measure on the “Fields” box as well. 

4. Drag the “Top Physicians” measure and drop it under the “Visual level filters” box. 

5. Expand the “Top Physicians” measure, set the operator to “is less than” and enter “6” in the box 
below. 

6. Navigate to the “Format” pane and make sure the following options are turned off. 

a. Category label 

b. Background 

c. Lock aspect 

7. Expand “Data labels” section. 

a. Set the “Color” to #666666. 

b. Set “Text” to 12. 

8. Expand “Card” section. 

a. Set “Outline” to “None”. 

b. Turn on “Show bar”. 

c. Set “Bar color” to #29B600. 

d. Set “Bar thickness” to 5. 

e. Set “Padding” to 20. 

9. Turn on and expand the “Title” section. 

a. Enter “Top 5 Physicians” in the “Title Text” box. 

b. Set “Font color” to #FFFFFF. 

c. Set “Background color” to #015C55. 

d. Set “Alignment” to center. 

e. Set “Text” to 20. 

10. Turn on and expand the “Border” section. 

a. Set the “Color” as # 666666. 
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11. Make a duplicate of the card visual that you just created. 

12. Select the duplicate card and navigate to the “Fields” pane. 

13. Make sure the following objects are placed in the “Fields” box. 

a. “Brand name” from “Medicine Master” table. 

b. “Medicine Order Count” from “Patent Medication” table. 

14. Drag and drop the “Top Medicines” measure from the “Medicine master” table on the “Visual 
Level Filter” box. 

15. Expand the “Top Medicines” measure, set the operator to “is less than” and enter “6” in the box 
below. 

16. Navigate to the “Format” pane. 

17. Expand “Card” section and set the “Bar color” to #0089CA. 

18. Expand “Title” section and enter “Top 5 Medicines” in the “Title Text” box. 

19. Make another duplicate of the card visual that you just created. 

20. Select the duplicate card and navigate to the “Fields” pane. 

21. Make sure the following objects are placed in the “Fields” box. 

a. “Procedure Name” from “Procedure Master” table. 

b. “Procedure Order Count” from “Patent Procedures” table. 

22. Drag and drop the “Top Procedures” measure from the “Procedure Master” table on the “Visual 

Level Filter” box. 

23. Expand the “Top Procedures” measure, set the operator to “is less than” and enter “6” in the 
box below. 

24. Navigate to the “Format” pane. 
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25. Expand “Card” section and set the “Bar color” to #B60048. 

26. Expand “Title” section and enter “Top 5 Procedures” in the “Title Text” box. 

27. Make another duplicate of the card visual that you just created. 

28. Select the duplicate card and navigate to the “Fields” pane. 

29. Make sure the following objects are placed in the “Fields” box. 

a. “Test Name” from “Test Master” table. 

b. “Test Order Count” from “Patent Tests” table. 

30. Drag and drop the “Top Tests” measure from the “Test Master” table on the “Visual Level Filter” 
box. 

31. Expand the “Top Tests” measure, set the operator to “is less than” and enter “6” in the box 
below. 

32. Navigate to the “Format” pane. 

33. Expand “Card” section and set the “Bar color” to #01842D. 

34. Expand “Title” section and enter “Top 5 Tests” in the “Title Text” box. 
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Creating a new page called “Death Analysis” 

1. Create a new page and name it as “Death Analysis”. 

2. Click anywhere on the white layout area and navigate to the “Format” pane. 

3. Expand the “Page Background” section and change the “Color” to #D0EEF7. You need click on 

“Custom Color” option to set the color using this hex code. 
 

Creating a Funnel Chart 

Using this visual we’d like to see the patient distribution as per different discharge dispositions. This would 

help in analyzing whether the patients are genuinely cured at the time of getting discharged from the 

hospital. Follow the below mentioned steps to create this visual. 
 

1. From the visualization gallery select “Funnel” chart and navigate to the “Fields” pane. 

2. Drag “Description” dimension (from Discharge Disposition table) and drop it on the “Group” box. 

3. Drag the “Admission Count” measure (from the Visits table) and drop it on the “Values” box. 

4. Hover on the visualization you just created and you should be able to see a white title bar popping 
up at the top. 

5. On the right side of that title bar there would two icons (Focus Mode and More Options). 

6. Click on “More Options” and select “Sort by Admission Count”. 

 
 

7. Navigate to the “Format” pane to apply some formatting to this visual. Make sure the following 
options are turned off. 

a. Conversion Rate 

b. Background 
c. Lock Aspect 

8. Turn on and expand the “Category Label” section. 

a. Set the “Color” to #666666. 
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9. Expand the “Data Colors” and enable the “Show all” slider. Set the color for “Expired” as 

#FF0010 and for all the other element set the color as #01B8AA. 

10. Expand “Data Labels” section. 

a. Set the “Color” to #666666. 

b. Set “Display” to “None”. 
c. Set “Position” to “Inside Center”. 

d. Set “Text” to 12. 
11. Turn on and expand the “Title” section. 

a. Enter “Admission Count by Discharge Disposition” in the “Title Text” box. 

b. Set the “Font Color” to #FFFFFF. 
c. Set the “Background Color” to #015C55. 

d. Set the “Alignment” to center. 

e. Set the “Text” to 20. 
12. Turn on and expand the “Border” section. 

a. Set the “Color” as # 666666. 
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Creating a 100% Stacked Bar Chart 

Using this visual we’d like to see the gender wise distribution of deaths. Follow the below mentioned 
steps to create this visual. 

 

1. From the visualization gallery select “100% Stacked Bar Chart” chart and navigate to the “Fields” 
pane. 

2. From the “Visits” table drag and drop the “Gender” dimension to “Legend” box. 

3. From the same table drag and drop the “Death Count” measure to the “Value” box. 

4. After dropping on the measure on the “Value” box, click on the small down arrow icon that 

appears to the right of “Death Count” and choose “Show value as” – “Percent of Grand Total”. 

5. Navigate to the “Format” panel and make sure that the following options are turned off. a. 
Background 

a. Lock Aspect 

6. Turn on and expand the “Legend” section. 

a. Set “Position” to “Top”. 
b. Turn on “Title’. 
c. Set “Legend Name” to “Gender”. 

d. Set “Color” to #666666. 
e. Set “Text” to 15. 

7. Turn on and expand the Y-Axis section. 

a. Set “Position” to “Left”. 

b. Set “Color” to #666666. 
c. Set “Text” to 11. 
d. Set “Minimum Category Width” to 20. 

8. Turn on and expand the X-Axis section. 

a. Set “Scale type” to “Linear”. 

b. Set “Color” to #666666. 
c. Set “Text” to 11. 
d. Turn off “Title”. 

9. Turn on and expand “Data color” section. 

a. Set the “Female” color to #FF4400. 

b. Set the “Male” color to #29B600. 
10. Turn on and expand “Data Label” section. 

a. Set “Color” to #FFFFFF. 

b. Set “Position” to “Auto”. 
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c. Set “Text” to 15. 
11. Turn on and expand “Title” section. 

a. Enter “Death% by Gender” in the “Title Text” box. 
b. Set “Font Color” to #FFFFFF. 

c. Set “Background Color” to #015C55. 
d. Set “Alignment” to “Center”. 

e. Set “Text” to 20. 
12. Turn on and expand the “Border” section. 

a. Set the “Color” as # 666666. 
 

 
 

 

Creating a Clustered Column Chart 

Using this visual we’d like to see, at which age group more deaths are caused. Follow the below 

mentioned steps to create this visual. 
 

1. From the visualization gallery select “Clustered Column Chart” chart and navigate to the “Fields” 
pane. 

2. From the “Visits” table drag and drop the “Age Group” dimension to the “Axis” box. 

3. From the same table drag and drop the “Death Count” measure to the “Values” box. 

4. After dropping on the measure on the “Value” box, click on the small down arrow icon that 

appears to the right of “Death Count” and choose “Show value as” – “Percent of Grand Total”. 

5. Navigate to the “Format” section and make sure that the following sections are turned off. a. 
Background 

b. Lock aspect 

6. Turn on and expand the X-Axis section. 

a. Set “Color” as #666666. 

b. Set “Text” as 15. 

c. Set “Minimum Category Width” to 20. 

d. Turn on “Concatenate Labels”. 

e. Turn off “Title”. 
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7. Turn on and expand the Y-Axis section. 

a. Set “Position” to “Left”. 

b. Set “Scale type” to “Linear”. 

c. Set “Color” as #666666. 

d. Set “Text” as 15. 

e. Set “Display” to “Auto”. 

f. Turn off “Title”. 

8. Expand the “Data Color” section. 

a. Make sure that the “Show all” slider is turned on. 

b. Set “Default Color” to #01B8AA. 

c. Set color for 0-10 as #29B600. 

d. Set color for 11-30 as #0089CA. 

e. Set color for 31-60 as #B60048. 

f. Set color for 61-90 as #01B8AA. 

g. Set color for 91-100 as #01842D. 

9. Turn on and expand “Data Labels” section. 

a. Set the “Color” to #666666. 

b. Set the “Display” to “Auto”. 

c. Set “Orientation” to “Horizontal”. 

d. Set “Position” to “Auto”. 

e. Set “Text” to 12. 
10. Turn on and expand “Title” section. 

a. Enter “Death% by Age Group” in the “Title Text” box. 

b. Set “Font Color” to #FFFFFF. 

c. Set “Background Color” to #015C55. 

d. Set “Alignment” to center. 

e. Set “Text” to 20. 

11. Turn on and expand the “Border” section. 

a. Set the “Color” as # 666666. 
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Creating a Map Visual 

Using this visual we’d like to see which geographic location is contributing to more patient deaths. 

Follow the below mentioned steps to create this visual. 
 

1. From the visualization gallery select “Map” chart and navigate to the “Fields” pane. 

2. From the “City Master” table drag “City Name” dimension and drop on the “Location” box. 

Please note the “Data Category” for this dimension needs to be set as “City” as mentioned in the 
previous module. 

3. From the “Visits table drag “Admission Count” measure and drop it on the “Size” box. 

4. Navigate to the “Format” tab and expand “Data Colors” section. 

5. Click on the ellipsis next to “Default color” and select “Conditional formatting”. 

 

a. On the “Default color – data colors” window, make sure “Format by” is set to “Color scale”. 

b. “Based on fields” is set to “Death count”. 

c. “Lowest value” color is set to #FF0010. 

d. “Highest value” color is set to #00FF65. 

e. Click on ok to save the settings. 

6. Navigate to the “format” pane and make sure the following options are turned off. 

a. Background 

b. Lock Aspect 

7. Turn on and expand the “Category Label” section. 

a. Set the “Text” to 12. 

b. Set the “Color” to #FFFFFF. 
8. Turn on and expand “Title” section. 

a. Enter “Death% by City Name” in the “Title Text” box. 

b. Set the “Font Color” to #FFFFFF. 

c. Set the “Background Color” to #015C55. 

d. Set the “Alignment” to center. 

e. Set the “Text” to 20. 

9. Turn on and expand the “Border” section. 

a. Set the “Color” as # 666666. 
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Applying Conditional Formatting on Grids 

In this section you’ll create a grid visual, using a collection of objects and apply conditional formatting on 

them using various available methods. Please note that we are creating this grid solely for the purpose of 

practicing. Hence, after you’ve learned how to apply conditional formatting, you may as well remove it 

from the report. 
 

1. From the visual gallery, click on the “Table” visual. 

2. This should create an empty frame on the layout area. 

3. While the empty frame is selected, expand the “Visits” table and, drag and drop the 

following objects in the “Values” drop box in the below mentioned sequence. 

a. “BMI Category” 

b. “Age Group” 

c. “Visit Count” 

d. “Death Count” 

e. “Length of Stay” 

f. “Admission Count” 

4. We’ll apply a conditional formatting on “Visit Count” measure using the “Background Color” 

option. To do this, 

a. Click on the small down arrow icon appearing next to the “Visit Count” pill, navigate to 
“Conditional Formatting” and select “Background Color”. 

 

b. From the “Background Color” screen, set the “Lowest Value” color to “#FEAB85” and 
the “Highest Value” color to “#00FF8B”. 
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c. Click on “Ok” to apply the formatting. 

d. Now the “Visit Count” values should look like this, 

 
 

5. We’ll apply a conditional formatting on “Death Count” measure using the 

“Font Color” option. To do this, 

a. Click on the small down arrow icon appearing next to the “Death Count” pill, 

navigate to “Conditional Formatting” and select “Font Color”. 

b. From the “Background Color” screen, select “Rules” from the “Format By” drop down list. 

Select “is greater than” operator from the “If Value” drop down list. 

c. Set the Value as “100” and choose “Number” from the next drop-down list. 

d. Set the font color as “#FF0000”. 
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e. Click on “Ok” to apply the formatting. 

f. Now the “Death Count” values should look like this, 

 

 
 

6. We’ll apply a conditional formatting on “Length of Stay” measure using the “Icons” option. To do 

this, 

a. Click on the small down arrow icon appearing next to the “Length of Stay” pill, 
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navigate to “Conditional Formatting” and select “Icons”. 

b. From the “Background Color” screen, make sure “Rules” is selected in the “Format By” drop 
down list. 

c. From the “Icon Layout” drop down list, select “Right of Data”. 

d. From the Styles drop down list, select the set of arrows . 

e. Set the rules as shown in the image below. 

 
 

f. Click on “Ok” to apply the formatting. 

g. Now the “Length of Stay” values should look like this, 

 
7. We’ll apply a conditional formatting on “Admission Count” measure using the “Data Bars” option. 

To do this, 

a. Click on the small down arrow icon appearing next to the “Admission Count” pill, 

navigate to “Conditional Formatting” and select “Data Bars”. 

b. From the “Data Bars” screen, make sure the “Minimum” value is set to “Lowest 
Value” and the “Maximum” value is set to “Highest Value”. 

c. The “Bar Direction” is set to “Right to Left”. 

d. The “Positive Bar” color is set to “#B9E5F3”. 
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e. The “Negative Bar” color is set to “#FEC0A3”. 

 

f. Click on “Ok” to apply the formatting. 

g. Now the “Admission Count” values and the rest of the grid should look like this, 
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Creating Mobile View 

Follow the below mentioned steps to create a mobile view using PowerBI desktop. 
 

1. Run the report you’ve been creating so far (using PowerBI desktop). 
2. Navigate to the “View” menu and click on “Phone Layout”. 

 
 

3. The mobile view page would contain a mobile compatible layout with a “Visualization” panel on 
the right. 

 

4. You need to create a mobile compatible view individually for every page of the report. To create a 

mobile compatible view of the “Hospital Performance” page, 

a. Navigate to the “Hospital Performance” page using the “Phone Layout” view. 

b. Drag and drop visualizations from the “Visualization” panel to the “Layout” area. 
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c. One by one, drag all the visuals you want to see in the mobile view. Arrange and resize 

them (by dragging and dropping) so that they fit in to the view properly. 

 
 

5. Repeat the same steps (4a to 4c) for each page in your report. 

6. Once the mobile compatible view is created, publish the report on your service account. 

7. Now using your phone device, download and install the PowerBI mobile app from the online store 
of your choice. 
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8. Run the mobile app once it’s downloaded and installed. 

9. Click on the ellipsis icon, appearing on top-left corner of the screen. 
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10. Click on “Connect to account”. 

 

11. On the next screen, click on “PowerBI. 

 

 
 

12. Enter the credentials to login to the service account where you’ve published the report. 

13. After logging in, once again click on the ellipsis icon appearing on the top-left corner of the screen 

and select the workspace where you’ve published the report. 
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14. Navigate to the “Reports” tab and run the report you just published. 
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15. The report would automatically show the mobile compatible view you created using PowerBI 
desktop. 

 

16. If you want to see the “Desktop view” using the mobile device, just change the orientation of the 

device and the desktop view would be shown. 

 

 
 
 

Note: The mobile device would show the mobile compatible view only if you have created one. Otherwise 
even with the mobile device, you’ll see only the default (desktop) view. 

 


